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Preface

Safety information

Note: For general safety information, see Appendix B, “Safety” on page 35.

MSDSs The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“MSDSs” on page 36.

IMPORTANT! For the MSDSs of chemicals not distributed by
Applied Biosystems or Ambion contact the chemical manufacturer.

How to use this guide

Text conventions This guide uses the following conventions:

* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a
drop-down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

User attention words Two user attention words appear in Applied Biosystems user documentation. Each
word implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to
the use of the product.

IMPORTANT! — Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.
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Preface
How to obtain support

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
* Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis,
and other related documents.

* Download PDF documents.
* Obtain information about customer training.
» Download software updates and patches.
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SOLID™ Whole Transcriptome Analysis Kit

Product information

Purpose of the product

Kit contents

Use the SOLiD™ Whole Transcriptome Analysis Kit (PN 4425680) to convert the
full set of RNA transcripts expressed in a cell or tissue into a cDNA library for
transcriptome analysis on the Applied Biosystems SOLiD™ Sequencing System.

High throughput sequencing of the transcriptome using the SOLiD System
enables genome-wide expression profiling with high sensitivity and a wider
dynamic range than microarray technology. Also, whole transcriptome library
preparation performed as described in this protocol preserves the strandedness of
the RNA transcripts. Preserving the strandedness simplifies data analysis, allows
determination of the directionality of transcription and gene orientation, and
facilitates detection of opposing and overlapping transcripts. Refer to “Overview
of the SOLiD™ Whole Transcriptome Analysis Kit procedure” on page 25 and
the workflow on page 4 for further details.

When used with the SOLiD™ Transcriptome Multiplexing Kit (PN 4427046), the
SOLiD Whole Transcriptome Analysis Kit can be used to prepare “barcoded”
libraries to enable sequencing of multiple transcriptome samples in a single,
multiplexed, SOLiD System sequencing run. Sequencing of multiplexed libraries
is fully supported by the SOLiD 3 System.

Sufficient reagents are supplied in the SOLiD Whole Transcriptome Analysis Kit
to prepare cDNA libraries from 12 samples for high-throughput sequencing with
the SOLiD System.

Table 1 SOLID™ Whole Transcriptome Analysis Kit components

Component Amount Cap
10X RNase Il Buffer 20 yL red
RNase llI 20 yL red
2X Ligation Buffer 150 pL green
Adaptor Mix A 30 pL green
Adaptor Mix B 30 pL purple
Hybridization Solution 40 yL green
Ligation Enzyme Mix 30 pL green
10X RT Buffer 50 yL yellow
ArrayScript™ Reverse Transcriptase 20 pL yellow
10XPCR Buffer 660 pL white
AmpliTag® DNA Polymerase 110 pL white
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SOLID™ Whole Transcriptome Analysis Kit
Materials and equipment not included

Table1 SOLID™ Whole Transcriptome Analysis Kit components (continued)

Component Amount Cap
dNTP Mix 500 pL white
SOLID™ 5’ PCR Primer 100 pL white
SOLiD™ 3’ PCR Primer 100 pL blue
Control RNA (1 pg/pL)* 50 pL clear
Nuclease-free Water 1.75mL clear

¥ Hela Total RNA
Storage Upon receipt of the SOLiD Whole Transcriptome Analysis Kit, immediately store

the components at —20 °C.

You may store the Nuclease-free Water at room temperature, 4 °C, or —20 °C.

Materials and equipment not included

Equipment
Item Source
Thermal cycler with heated lid, capable of holding 0.2-mL Applied Biosystems
tubes:
o Veriti® 96-Well Thermal Cycler
¢ GeneAmp® PCR System 9700
Qubit® Fluorometer Invitrogen PN Q32857
XCell SureLock™ Mini-Cell Invitrogen PN EI0001
Agilent 2100 Bioanalzyer Agilent PN G2938A
NanoDrop™ Spectrophotometer Thermo Scientific
Note: May be used instead of the Qubit Fluorometer, but the
results from the NanoDrop Spectrophotometer are less
accurate.
Centrifugal vacuum concentrator (for example, SpeedVac) MLS
Microcentrifuge MLS
Pipettors, positive displacement or air-displacement MLS
Transilluminator MLS
Supplies

Item Source

8-strip PCR Tubes & Caps, RNase-free, 0.2-mL Applied Biosystems PN AM12230
Non-Stick RNase-free Microfuge Tubes (0.5 mL), Applied Biosystems PN AM12350

500

Non-Stick RNase-free Microfuge Tubes (1.5 mL), Applied Biosystems PN AM12450
250

Pipette tips, RNase-free MLS

2 SOLID™ Whole Transcriptome Analysis Kit Protocol



Reagents

(Optional) Barcoded
primers for multiplex
SOLiIiD™ System
sequencing

SOLID™ Whole Transcriptome Analysis Kit
Materials and equipment not included

Item Source

Nuclease-free Water (not DEPC-treated), 100 mL Applied Biosystems PN AM9938

50 bp DNA Ladder* Invitrogen PN 10416-014
Novex® 6% TBE-Urea Gels 1.0 mm, 10 well* Invitrogen PN EC6865BOX
Novex® TBE-Urea Sample Buffer (2X), 10 mL* Invitrogen PN LC6876
Novex® TBE Running Buffer (5X), 1 L¥ Invitrogen PN LC6675
PureLink™ PCR Micro Kit, 50 preps? Invitrogen PN K310050
PureLink™ RNA Micro Kit, 50 preps* Invitrogen PN 12183016

Note: This kit is required only if the RiboMinus
Concentration Module is not available.

Quant-iT™ RNA Assay Kit, 100 assays? Invitrogen PN Q32852
RiboMinus™ Concentration Module, 6 preps* Invitrogen PN K1550-05

Note: The RiboMinus™ Concentration Module is
not equivalent to the RiboMinus™ Eukaryote Kit
for RNA-Seq or to the RiboMinus™ Plant Kit for

RNA-Seq.

SYBR® Gold nucleic acid gel stain, 10,000X Invitrogen PN S-11494
concentrate in DMSO, 500 pL*

Agilent DNA 1000 Kit# Agilent PN 5067-1504
Agilent RNA 6000 Pico Chip Kit# Agilent PN 5067-1513
MinElute® PCR Purification Kit (50)* Qiagen PN 28004
Ethanol, 100%, ACS reagent grade or equivalent? MLS

T For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical
manufacturer. Before handling any chemicals, refer to the MSDS provided by the manufacturer, and
observe all relevant precautions.

The Applied Biosystems SOLiD™ Transcriptome Multiplexing Kit

(PN 4427046) includes a set of 16 SOLiD 3’ PCR Primers that are individually
“barcoded” for multiplex SOLiD System sequencing. Instructions for using the
barcoded primers are included in this protocol.
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SOLID™ Whole Transcriptome Analysis Kit
Workflow

Workflow

Fragmentation of whole transcriptome RNA

0.1-1 pg poly(A) RNA or 0.2-1 ug total RNA or rRNA-depleted total RNA
Fragment the RNA (page 5)

Clean up the RNA (page 6) A’\‘,’.‘ M~

. . N . Fragmented RNA
Assess the yield and size distribution of the fragmented RNA (page 7)

3

Amplified library construction

Hybridize and ligate the RNA (page 10)

- Adaptor Mix
",f::;: + NNNNN — NNNNN
Ligation Junctions
fa—~——y
NNNNN  NNNNN
Perform reverse transcription (page 11) - m
Purify the cDNA (page 12) —_— CcDNA
Size select the cDNA (page 13) [[I]] ey

Amplify the cDNA (page 17) 5 PCR Primer (P1)

Barcode
(P2)

Purify the amplified DNA (page 18) 3' PCR Primer
P1 sequence internal adaptor (IA) P2 sequence
Assess the yield and size distribution of the amplified DNA (page 19) RNA soquonce ba'm—de“(gé')”“”“”'

!

SOLiD™ System templated bead preparation and sequencing

Proceed with the Applied Biosystems SOLID™ 3 System Templated Bead
Preparation Guide (PN 4407421)
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SOLID™ Whole Transcriptome Analysis Kit
Fragmentation of whole transcriptome RNA

Fragmentation of whole transcriptome RNA

Overview Fragmentation of the whole transcriptome RNA involves the following
procedures:

1. Fragment the RNA (below)
2. Clean up the RNA (page 6)

3. Assess the yield and size distribution of the fragmented RNA (page 7)

RNA sample type and Use 0.1-1 pg poly(A) RNA or 0.2—1 ug total RNA or rRNA-depleted total RNA.

mount . . .
amod * For poly(A) RNA, Applied Biosystems recommends performing two rounds

of oligo(dT) selection of the poly(A) RNA; for example, use the

Applied Biosystems Poly(A)Purist™ Kit (PN AM1916). Also, confirm the
absence of 18S and 28S rRNA; for example, check the profile of the poly(A)
RNA on an Agilent 2100 Bioanalyzer.

* For rRNA-depleted total RNA, Applied Biosystems recommends that you
remove TRNA from total RNA for transcriptome analysis using the Invitrogen
RiboMinus"" Eukaryote Kit for RNA-Seq (PN A1083708) or the Invitrogen
RiboMinus™ Plant Kit for RNA-Seq (PN A1083808).

Use only high-quality RNA as your starting material. FirstChoice® Total RNA and
Poly(A) RNA provide high-quality, intact RNA isolated from a variety of sources.

Fragment the RNA Use components from the SOLiD" Whole Transcriptome Analysis Kit:

e Nuclease-free Water
* 10X RNase III Buffer
¢« RNase III

1. For each RNA sample, assemble a reaction mixture on ice:

Component Volume

RNA sample: <8 uL
¢ Poly(A) RNA: 0.1-1 pg

e Total RNA: 0.2-1 g

¢ rRNA-depleted total RNA: 0.2-1 ug

Nuclease-free Water to 8 uL
10X RNase |l Buffer 1pL
RNase llI 1L
Total volume 10 puL

2. Flick the tube or pipet up and down a few times to mix, then spin briefly.

3. Incubate the reaction in a thermal cycler at 37 °C for 10 minutes.
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SOLID™ Whole Transcriptome Analysis Kit
Fragmentation of whole transcriptome RNA

4. Immediately after the incubation, add 90 uL of Nuclease-free Water, then
place the fragmented RNA on ice. Go to the next step immediately, or leave
the fragmented RNA on ice for less than 1 hour.

Clean up the RNA Use the RiboMinus™ Concentration Module (Invitrogen).

Alternatively, you can use the PureLink™ RNA Micro Kit (Invitrogen) (page 27).

1. Prepare the Wash Buffer (W5) with ethanol, then store at room temperature:

Component Volume
100% ethanol 6 mL
Wash Buffer (W5) 1.5mL

2. Add to the fragmented RNA, then mix well:

Component Volume
Binding Buffer (L3) 100 L
100% ethanol 250 L

3. Bind the RNA sample containing Binding Buffer (L3) and ethanol to the
Spin Column:

a. Place the Spin Column in a clean 1.5-mL Wash Tube.

b. Load 450 puL of the RNA sample containing Binding Buffer (L3) and
ethanol onto the Spin Column.

c. Spin the column at 12,000 x g for 1 minute.

d. Discard the flowthrough.

4. Wash the RNA:
a. Return the Spin Column to the Wash Tube.
b. Add 500 pL of Wash Buffer (W5) with ethanol to the Spin Column.
c. Spin the column at 12,000 x g for 1 minute.
d. Discard the flowthrough.
e. Return the Spin Column in the Wash Tube.

f. Spin the column at maximum speed for 2 minutes.

5. Elute the RNA in a clean Recovery Tube:
a. Place the Spin Column in a clean Recovery Tube.
b. Add 20 uL of RNase-Free Water to the center of the Spin Column.

c. Wait 1 minute, then spin the column at maximum speed for 1 minute.

6 SOLID™ Whole Transcriptome Analysis Kit Protocol



SOLID™ Whole Transcriptome Analysis Kit
Fragmentation of whole transcriptome RNA

Assess the yield and Use the Quant-iT™ RNA Assay Kit with the Qubit® Fluorometer (Invitrogen) and
size distribution of the the RNA 6000 Pico Chip Kit with the Agilent ® 2100 Bioanalyzer (Agilent).

fragmented RNA

Note: You can use a NanoDrop™" Spectrophotometer in place of the Quant-iT
RNA Assay Kit and Qubit Fluorometer. However, RNA eluted from spin columns
may contain extra salts or other components that affect readings on the NanoDrop
Spectrophotometer. For increased accuracy, quantitate the RNA concentration
using the Quant-iT RNA Assay Kit on the Qubit Fluorometer.

1. Quantitate the yield of the fragmented RNA using the Quant-iT RNA Assay
Kit on the Qubit Fluorometer.

Refer to the Quant-iT"™ RNA Assay Kit Protocol or the Qubit® Fluorometer
Instruction Manual by Invitrogen for instructions.

Note: The Quant-iT RNA Assay Kit requires more than 5 ng RNA in each
assay for accurate quantitation. If you started with less than 200 ng RNA, use
2-3 uL for the Quant-iT RNA Assay or concentrate your sample with a
centrifugal vacuum concentrator.

2. Assess the size distribution of the fragmented RNA:

a. Dilute the RNA to less than 5 ng/ulL.

b. Run 1 pL on an Agilent 2100 bioanalyzer with the RNA 6000 Pico Chip
Kit. Follow the manufacturer’s instructions for performing the assay.

c. Using the 2100 expert software, review the size distribution.

The fragmentation procedure should produce a distribution of RNA
fragment sizes from 35 nt to several hundred or a few thousand nt,
depending on your sample type. The average size should be 100—200 nt.
See Figures 1 and 2 on page 8.

Note: For instructions on how to review the size distribution, refer to
the Agilent 2100 Bioanalyzer 2100 Expert User’s Guide by Agilent.

3. Proceed according to the amount of fragmented RNA you have in 3 pL:

Amount of fragmented
RNA in 3 puL

Instructions

e >50 ng poly(A) RNA

e >100 ng rRNA-
depleted total RNA

e <50 ng poly(A) RNA

* <100 ng rRNA-
depleted total RNA

Proceed with “Amplified library construction” on
page 9.

Store the remaining RNA at —80 °C.
1. Dry 50-100 ng of the RNA completely in a

centrifugal vacuum concentrator at low or medium
heat (<40 °C); this should take 10-20 minutes.

2. Resuspend in 3 pL Nuclease-free Water, then
proceed with “Amplified library construction” on
page 9.
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SOLID™ Whole Transcriptome Analysis Kit
Fragmentation of whole transcriptome RNA

Typical results of Figure 1 and Figure 2 show profiles from an Agilent 2100 Bioanalyzer after
fragmentation of whole  RNase III fragmentation and cleanup. Figure 1 shows results with HeLa poly(A)
transcriptome RNA RNA. Figure 2 shows results with rRNA-depleted HeLa RNA.
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Figure 1 Size distribution of fragmented HeLa poly(A) RNA
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Figure 2 Size distribution of fragmented rRNA-depleted HeLa RNA
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SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

Amplified library construction

Overview

Choose Adaptor Mix A
or Adaptor Mix B for
use

SOLID™ Whole Transcriptome Analysis Kit Protocol

Amplified library construction involves the following procedures:

1.

2.

Hybridize and ligate the RNA (page 10)

Perform reverse transcription (page 11)

Purify the cDNA (page 12)

Size select the cDNA (page 13)

Amplify the cDNA (page 17)

Purify the amplified DNA (page 18)

Assess the yield and size distribution of the amplified DNA (page 19)

Proceed with SOLiD™ System templated bead preparation (page 20)

If you are preparing only one whole transcriptome library, use Adaptor
Mix A; this will prepare template for SOLiD™ System sequencing from the
5’ end of the sense strand of the RNA.

To achieve higher confidence in the complete sequence of larger RNAs in the
whole transcriptome, prepare two separate whole transcriptome RNA
libraries, using Adaptor Mix A in the hybridization reaction for one library
and Adaptor Mix B in the hybridization reaction for the other library. (Do not
mix the libraries for SOLiD System sequencing unless they are barcoded.)

Adaptor Mix B yields template for sequencing the reverse complement of the
RNA, providing sequencing information from the 3” end of the sense strand.

For further information, refer to “Overview of the SOLiD™ Whole Transcriptome
Analysis Kit procedure” on page 25.

-

Adaptor Mix A
P1
@ 5. > NS 3
g LLITTTTTTTTTTTTTTTTTT7T RNA Sequence  Sinternal Adapter ] barcode | [TTTTTTTTTTTTTIT
i P2
5\ N\ N\TG
FORWARD
Adaptor Mix B
N
P1 ,
@ 5" > . 3
LTI ITIT < AvA Sequence  [internal Adapter] barcode [ [ [T [T TTTTTTTITIT 5
; N .,
“ie P2
INNNNNYE
REVERSE

Figure 3 Adaptor Mix choice and RNA sequence



SOLID™ Whole Transcriptome Analysis Kit

Amplified library construction

Hybridize and ligate the  Use components from the SOLiD™ Whole Transcriptome Analysis Kit:

RNA

10

Adaptor Mix A or Adaptor Mix B
Hybridization Solution
Nuclease-free Water

2X Ligation Buffer

Ligation Enzyme Mix

. On ice, prepare the hybridization mix in 0.2 mL PCR tubes:

Component Volume
Adaptor Mix A or B* 2L
Hybridization Solution 3L
Fragmented RNA sample: 3 uL

e Poly(A) RNA: 50 ng
¢ Total RNA: 100 ng
* rRNA-depleted total RNA: 100 ng

Total volume per reaction 8 uL

I Use Adaptor Mix A for SOLID System sequencing from the 5’ end. Use
Adaptor Mix B for sequencing from the 3" end. To sequence the RNAs
from both the 5" and 3" ends, set up two ligation reactions, each with one
Adaptor Mix.

Slowly pipet up and down a few times to mix well, then spin briefly.

Run the hybridization reaction in a thermal cycler:

Temperature Time
65 °C 10 min
16 °C 5 min

Add the RNA ligation reagents to the 8-uL hybridization reactions:

Component (add in order shown) Volume
2X Ligation Buffer* 10 pL
Ligation Enzyme Mix 2 uL

I 2X Ligation Buffer is very viscous; pipet slowly to dispense it
accurately.

Flick the tube or slowly pipet up and down a few times to mix well, then spin
briefly.

Incubate the 20-uL ligation reaction in a thermal cycler at 16 °C for 16 hours.
Note: If possible, set the temperature of the thermal cycler lid to match the

block temperature. Otherwise, incubate the reaction with the heated lid
turned off, or do not cover the reaction tubes with the heated lid.

SOLID™ Whole Transcriptome Analysis Kit Protocol



Perform reverse
transcription

SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

Use components from the SOLiD™ Whole Transcriptome Analysis Kit:

Nuclease-free Water

10X RT Buffer

dNTP Mix

ArrayScript™ Reverse Transcriptase

. Onice, prepare 20 uL of RT Master Mix for each sample:

Component Volume
Nuclease-free Water 13 pL
10X RT Buffer 4L
dNTP Mix 2L
ArrayScript™ Reverse Transcriptase 1L
Total volume per reaction 20 uL

Note: Include 5-10% excess volume in the master mix to compensate for
pipetting error.

On ice, add 20 pL of RT Master Mix to each 20-uL ligation reaction.
Gently vortex to mix thoroughly, then spin briefly.

Incubate the 40-uL RT reaction in a thermal cycler with a heated lid at 42 °C
for 30 minutes.

Note: The cDNA can be stored at —20 °C for a few weeks, stored at —80 °C
for long-term storage, or used immediately.

SOLID™ Whole Transcriptome Analysis Kit Protocol 11



SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

Purify the cDNA Use the MinElute® PCR Purification Kit (Qiagen).

Note: The kit may be supplied with Buffer PB (without pH Indicator) or Buffer
PBI (with pH Indicator). Either buffer can be used as is; it is not necessary to add
pH Indicator to Buffer PB before use.

1. Add Nuclease-free Water and Buffer PB or Buffer PBI to the cDNA:

a. Transfer all of the cDNA (40 uL) to a clean 1.5-mL microcentrifuge
tube.

b. Add 60 pL of Nuclease-free Water.
c. Add 500 pL of Buffer PB or Buffer PBI, then mix well.

2. Load the cDNA onto the MinElute column:

a. Load 600 uL of the sample containing Buffer PB or Buffer PBI onto the
MinElute column.

b. Spin the column at 13,000 x g for 1 minute.

c. Discard the flowthrough.

3. Wash the cDNA:
a. Return the MinElute column to the microcentrifuge tube.
b. Add 750 puL of Buffer PE to the MinElute column.
c. Spin the column at 13,000 x g for 1 minute.
d. Discard the flowthrough.
e. Return the MinElute column to the microcentrifuge tube.

f. Spin the column at 13,000 x g for 1 minute.

4. Elute the cDNA in a clean microcentrifuge tube:
a. Place the MinElute column in a clean microcentrifuge tube.
b. Add 10 uL of Buffer EB to the center of the MinElute column.

c. Wait 1 minute, then spin the column at 13,000 x g for 1 minute.

12 SOLID™ Whole Transcriptome Analysis Kit Protocol



SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

Size select the cDNA Use Novex® pre-cast gel products, a 50 bp DNA Ladder, and SYBR® Gold
nucleic acid gel stain (Invitrogen):
+ Novex® 6% TBE-Urea Gel 1.0 mM, 10 Well
+ Novex® TBE Running Buffer (5X)
+  Novex® TBE-Urea Sample Buffer (2X)
»  XCell SureLock™ Mini-Cell
* 50 bp DNA Ladder
+ SYBR® Gold nucleic acid gel stain

For more instructions on running Novex gels, refer to the Novex® Pre-Cast Gel
Electrophoresis Guide by Invitrogen.

For more instructions on staining the gel, refer to the SYBR® Gold Nucleic Acid
Gel Stain manual by Invitrogen.
1. Prepare the gel as described in the Novex® Pre-Cast Gel Electrophoresis
Guide by Invitrogen:

a. Prepare 1000 mL of 1X TBE Running Buffer:

Component Volume
Novex® TBE Running Buffer (5X) 200 mL
Deionized water 800 mL
Total volume 1000 mL

Prepare 1000 mL of 1X TBE Running Buffer using Novex® TBE
Running Buffer (5X).

b. Place the Novex® 6% TBE-Urea Gel in the XCell SureLock"™ Mini-Cell.

c. Add 1X TBE Running Buffer to the Upper Buffer Chamber and the
Lower Buffer Chamber.

2. Dilute the 50 bp DNA Ladder:

Component Volume Concentration
50 bp DNA Ladder 1L 1 pg/ul
RNase-free water 24 uL -
Total volume 25 pL 40 ng/pL

3. Prepare the cDNA and the DNA ladder:

a. Mix 5 pL of the cDNA with 5 uLL of 2X Novex TBE-Urea Sample
Buffer.

b. Mix 5 pL of the 40 ng/uL. 50 bp DNA Ladder with 5 uL. of 2X Novex
TBE-Urea Sample buffer.

c. Heat the cDNA and the DNA Ladder at 95 °C for 3 minutes.

SOLID™ Whole Transcriptome Analysis Kit Protocol 13



SOLID™ Whole Transcriptome Analysis Kit

Amplified library construction

14

d. Snap-cool the tubes on ice. Leave the tubes on ice for less than
30 minutes.

Note: Do not leave denatured samples on ice for longer than 30
minutes. If the denatured samples are left on ice for longer than 30
minutes, repeat step 3¢ before loading the samples.

. Before you load the samples, flush the wells of the gel several times with 1X

TBE Running Buffer to remove urea from the wells.

Note: Flushing the wells is important to obtain sharp bands.

. Load the cDNA samples and the DNA Ladder, avoiding the lanes next to the

edges of the gel.

Note: Load the DNA Ladder to the left of the cDNA sample. If you have
multiple samples, load the DNA Ladder to the left of each cDNA sample.

. Run the gel at 180 V for ~17 minutes or until the leading dye front reaches

the middle of the gel.

IMPORTANT! Do not run the gel too long.

. Stain the gel with SYBR® Gold nucleic acid gel stain for 5-10 minutes.

* AddS5 pL of the SYBR Gold nucleic acid gel stain to 50 mL of 1X TBE
Running Buffer.

. IMluminate the stained gel, then excise the gel containing 100—200 nt cDNA:

Note: Be careful not to include extra gel that does not contain any cDNA.

a. Using a clean razor blade, make horizontal cuts to excise the gel
containing 100-200 nt cDNA.

SOLID™ Whole Transcriptome Analysis Kit Protocol



SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

Make the horizontal cuts first to obtain the
desired insert length

Note: If you are using a UV transilluminator to visualize the reaction
products, work quickly to limit their exposure to UV radiation.

Note: To obtain the desired insert length, you can adjust the cuts.
However, too much gel will severely inhibit the PCR reactions. See
Table 2 on page 16 for the expected lengths of the insert and PCR
product according to the length of the cDNA that is excised from the
gel.

b. Reduce the width of the gel piece by making vertical cuts on both edges
of the smear.

Make the vertical cuts on the
edges of the smear

200
150

100

9. Transfer the gel piece to a clean working area, maintaining the orientation of
the gel, then cut the gel vertically into 4 pieces using a clean razor blade.
Each gel slice should be about 1 mm X 6 mm.

Cut the gel vertically into 4 pieces

SOLID™ Whole Transcriptome Analysis Kit Protocol 15



SOLID™ Whole Transcriptome Analysis Kit
Amplified library construction

10. Place the two gel slices from the middle of the lane individually into clean
0.2-mL PCR tubes, and place the outside gel slices into a clean 1.5-mL
microcentrifuge tube for storage.

To generate sufficient cDNA for accurate quantitation, you need to run 2

amplification reactions using 2 gel pieces, 1 gel piece in each reaction. You
may store the other 2 pieces for 2 weeks at —20 °C.

Note: To maximize the yield for SOLiD System sequencing, use the 2 gel
pieces from the middle of the lane.

Example of size Figure 4 shows 5 pL of purified cDNA from HeLa poly(A) RNA run on a Novex

selection 6% TBE-Urea Gel with the Invitrogen 50 bp DNA Ladder. The white rectangle
indicates the area of the gel to excise. Each vertical slice can be used for one
100-uL PCR.

Region of excision

Figure 4 Example of size selection of cDNA from HeLa poly(A) RNA

Expected lengths of the  Table 2 Expected lengths of the insert and PCR product according to
insert and PCR product  excised cDNA length

according to excised
cDNA length Excised cDNA length (nt) Insert length (bp) PCR product length (bp)
50 ~0 ~100
100 ~50 ~150
150 ~100 ~200
200 ~150 ~250
250 ~200 ~300
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Amplify the cDNA Use components from the SOLiD™ Whole Transcriptome Analysis Kit:

SOLID™ Whole Transcriptome Analysis Kit Protocol

Nuclease-free Water

10X PCR Buffer

2.5 mM dNTP Mix

SOLiD™ 5’ PCR Primer

AmpliTaq® DNA Polymerase

SOLiD™ 3’ PCR Primer

(Optional) To prepare cDNA libraries for multiplex SOLiD System

sequencing, substitute barcoded SOLiD™ 3’ Primers from the SOLiD™
Transcriptome Multiplexing Kit.

Note: Plan your experiments to include multiples of four different barcoded
libraries in every multiplex sequencing pool, to preserve color balance on the
SOLID System sequencing run. Use the SOLiD 3’ Primers from the SOLiD
Transcriptome Multiplexing Kit in these color-balanced groups: BC1-BC4,
BC5-BCS8, BC9-BC12, or BC13—-BC16. For further information, refer to
SOLiD™ Transcriptome Multiplexing Kit Product Insert (PN 4441076) and
SOLiD™ 3 System SETS Software Getting Started Guide (PN 4389302).

. For each cDNA sample, prepare duplicate in-gel amplification reactions to

generate sufficient cDNA for emulsion PCR:

a. Ensure that each gel slice from step 10 on page 16 is placed in a 0.2-mL
PCR tube. If necessary, transfer the gel slice to the PCR tube using a
clean pipette tip.

b. Prepare 98 uL. PCR master mix for each gel slice:

Volume
Component One 100-pL Two 100-pL
reaction reactions¥
Nuclease-free Water 76.8 pL 169.0 pL
10X PCR Buffer 10 yL 22.0 yL
dNTP Mix 8 uL 17.6 pL
SOLID™ 5’ PCR Primer 2L 4.4 L
AmpliTag® DNA Polymerase 1.2 uL 2.6 pL
Total volume 98 uL 215.6 L

1 When preparing PCR master mix for multiple reactions, it is best to include 5-10%
excess volume to compensate for pipetting error. The table shows 10% excess.

c. Transfer 98 uL. PCR master mix into each 0.2-mL PCR tube.

d. Add 2 pL SOLiD 3’ PCR Primer to each tube.

(Optional) Substitute 2 uL of barcoded SOLiD 3’ Primer from the
SOLIiD Transcriptome Multiplexing Kit for each sample, as described
above.
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Purify the amplified
DNA

18

2. Run the PCR reactions in a thermal cycler:

Stage Temp Time
Hold 95 °C 5 min
Cycle (15 cycles) 95 °C 30 sec
62 °C 30 sec

72°C 30 sec

Hold 72°C 7 min

Note: Run 15 cycles if you started with 50-100 ng of fragmented RNA. If
necessary, adjust the number of cycles according to the amount of input
fragmented RNA, but for optimal results run between 12 and 18 cycles. Too
many cycles results in overamplification and changes the expression profile.

Use the PureLink™ PCR Micro Kit (Invitrogen):

+ PureLink™ Micro Kit Column
* Collection Tube

* Binding Buffer (B2)

*  Wash Buffer (W1)

+ PureLink™ Elution Tube

IMPORTANT! Do not use other PCR purification kits. Other purification Kits are
not as effective in the removal of unincorporated primers. Unincorporated primers
can affect the final quantitation and emulsion PCR.

1. Prepare the sample:

a.

b.

Combine the two 100-uL PCR reactions in a new 1.5-mL tube.

IMPORTANT! If you used two different barcoded SOLiD 3’ Primers for
your sample, do not combine the PCRs at this step.

Add 800 uL of Binding Buffer (B2) to the tube, then mix well.

2. Load the sample onto the PureLink " Micro Kit Column:

a.

b.

Place the PureLink™ Micro Kit Column in a clean Collection Tube.

Load 500 pL of the sample containing Binding Buffer (B2) onto the
column.

Spin the column at 10,000 x g for 1 minute.

. Discard the flowthrough.

Load the remaining 500 pL of the sample containing Binding Buffer
(B2) onto the column.
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f. Spin the column at 10,000 x g for 1 minute.

g. Discard the flowthrough.

3. Wash the DNA:
a. Return the column to the Collection Tube.
b. Add 600 pL of Wash Buffer (W1) to the column.
c. Spin the column at 10,000 x g for 1 minute.
d. Discard the flowthrough.
e. Return the column to the Collection Tube.

f.  Spin the column at 14,000 x g for 1 minute.

4. Elute the DNA in a clean PureLink "~ Elution Tube:
a. Place the column in a clean PureLink'" Elution Tube.
b. Add 10 pL of Elution Buffer to the center of the membrane.

c. Wait 1 minute, then spin the column at 14,000 x g for 1 minute.

d. Repeat step 4b through step 4c for a total elution volume of 20 pL.
Assess the yield and Use a NanoDrop spectrophotometer, and the Agilent 2100 Bioanalyzer with the
size distribution of the DNA 1000 Kit (Agilent).

amplified DNA
1. Measure the concentration of the purified DNA with a NanoDrop

spectrophotometer, and if necessary, dilute the DNA to <50 ng/uL for
accurate quantitation with the DNA 1000 Kit.

2. Run 1 pL of the purified DNA on an Agilent 2100 Bioanalyzer with the
DNA 1000 Kit. Follow the manufacturer’s instructions for performing the
assay.

3. Using the 2100 expert software, perform a smear analysis to quantify the
percentage of DNA that is 25—150 bp.

Percent of DNA in

the 25-150 bp range Next steps
Less than 20% Proceed with SOLID™ System templated bead
preparation (see page 20).
Greater than 20% Follow the troubleshooting instructions for “Normal yield
and bad size distribution in the amplified library” on
page 22.

Note: For instructions on how to perform the smear analysis, refer to
“Setting up a smear analysis” on page 29, and to the Agilent 2100
Bioanalyzer 2100 Expert User’s Guide by Agilent.
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Proceed with SOLID™
System templated bead
preparation

Typical size profiles of
amplified libraries

20

4. Determine the median peak size (bp) and molar concentration (nM) of the
cDNA library using the Agilent software. For more information, refer to
“Selected settings in Agilent bioanalyzer software” on page 29.

Note: The mass concentration of the cDNA must be <50 ng/uL for accurate
quantitation with the DNA 1000 Kit.

Alternatively, obtain the mass concentration by another method, and convert
the mass concentration to molar concentration. A concentration conversion
calculator is available at:

www4.appliedbiosystems.com/techlib/append/concentration_calculator.html

When less than 20% of the amplified DNA is in the 25-150 bp range, you can
proceed with the SOLiD™ System templated bead preparation stage, in which
each library template is clonally amplified on SOLiD™ P1 DNA Beads by
emulsion PCR. Refer to the Applied Biosystems SOLiD™ 3 System Templated
Bead Preparation Guide (PN 4407421).

Barcoded libraries are pooled prior to templated bead preparation. For more
information refer to SOLID™ Transcriptome Multiplexing Kit Product Insert
(PN 4441076).

Note: When optimizing SOLiD Whole Transcriptome Analysis Kit library
concentrations (singleplex or multiplex sequencing pools) by workflow analysis
(WFA), library concentrations of 0.4 pM and 0.8 pM for ePCR are recommended.

Typical size distributions (Agilent 2100 Bioanalyzer profiles) of amplified
libraries prepared from HeLa poly(A) RNA (Figure 5) and rRNA-depleted HeLa
RNA (Figure 6) using the SOLiD™ Whole Transcriptome Analysis Kit are shown.
Figure 7 is an example of a sub-optimal size distribution with >20% DNA
25-150 bp in length, prepared from rRNA-depleted FirstChoice® Human Brain
Reference RNA (PN AM6050).
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Figure 5 Size distribution of amplified library prepared from HeLa poly(A)
RNA
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Figure 6 Size distribution of amplified library prepared from rRNA-depleted
Hela total RNA
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Figure 7 Sub-optimal size distribution of ampilified library

The recovery of your experimental RNA will depend on its source and quality.
The following results are typically seen with Human Brain Reference and HeLa
RNAs.

Workflow Input amount Typical recovery amount
Fragmentation of whole transcriptome = 1 ug poly(A) RNA, total RNA, or rRNA- 500-800 ng RNA
RNA (page 5) depleted total RNA
Amplified library construction (page 9) = 50-100 ng fragmented RNA >200 ng cDNA
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Troubleshooting

Observation

Possible cause

Solution

Agilent software doesn’t calculate one
concentration and peak size

Low yield and bad size distribution in
the amplified library

Low yield in the amplified library and
very few differences in the 2100
bioanalyzer traces before and after
you fragment the RNA

Low yield and no PCR products

Normal or high yield but the purified
amplified cDNA shows one or more
sharp peaks between 100 and 150 bp
in the Agilent 2100 Bioanalyzer trace

Normal or high yield but PCR
products larger than 300 bp

Normal yield and bad size distribution
in the amplified library

The software detects multiple peaks in
the amplified cDNA profile

You recovered <20% of the input RNA
after you fragmented the RNA and
cleaned up the RNA

RNA fragmentation failed

The gel ran too long or too much gel
was added to the PCR

An enzymatic reaction or column
purification performed after RNase lll
treatment failed

Nonspecific amplification

Too many PCR cycles resulted in
overamplification

Too much sample was loaded on the
Novex® TBE-Urea Gel

The wells of the Novex TBE-Urea Gel
contained urea

Refer to “Manual adjustment for
multiple peaks” on page 31.

Decrease the RNase Il digestion from
10 minutes to 5 minutes (step 3 on

page 5).

Fragment the RNA again with a
positive control, then if RNA
fragmentation is successful with the
positive control, increase the RNase lll
digestion from 10 minutes to

20 minutes (step 3 on page 5).

Reduce the running time (step 6 on
page 14) and add less gel to the PCR
(step 1 on page 17).

1. Dilute the cDNA 1:10, then use
1 pL in a 100-pL PCR.

2. Check the yield before and after
purification using the PureLink™
PCR Micro Kit.

3. If you get the same results, repeat
the ligation with more fragmented
RNA, and run a parallel ligation
reaction with fragmented Control
RNA.

Increase the PCR annealing
temperature to 68-72 °C (step 2 on
page 18).

Decrease the number of PCR cycles
(step 2 on page 18).

Decrease the volume of sample
loaded to less than 10 pL (step 5 on
page 14).

Before you load the samples, flush the
wells of the gel several times with 1X
TBE Running Buffer to remove urea
from the wells and to obtain sharp
bands (step 4 on page 14).

You decreased the volume of sample
loaded on the Novex® TBE-Urea Gel,
but smear analysis of the purified
amplified cDNA shows that >20% of
the cDNA is in the 25-150 bp range.

Fragmented RNA sample contains too
many small fragments

Size selection was not successful

Follow “Second-round size selection
of amplified cDNA” on page 32.

22
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Positive control reaction A general troubleshooting strategy is to perform the SOLiD™ Whole
Transcriptome Analysis Kit procedure using the Control RNA (HeLa total RNA)
provided with the kit.

» Use 0.2-1 pg Control RNA for the fragmentation procedure starting on
page S.

+ Use 100 ng fragmented Control RNA in the amplified library construction
procedure starting on page 9.

* The expected yields for the Control RNA are listed on page 21.
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Overview of the SOLIiD™ Whole Transcriptome Analysis Kit

procedure

Fragmentation of whole
transcriptome RNA

Amplified library
construction

The procedure is based on Applied Biosystems Ligase-Enhanced Genome
Detection (Ambion LEGenD™) technology (patent pending); an overview is
shown in the workflow on page 4.

Poly(A) RNA, total RNA, or ribosomal RNA-depleted total RNA is first
fragmented using RNase 111, to convert the whole transcriptome sample to RNA of
a size appropriate for SOLiD™ System sequencing. After cleanup using the
RiboMinus™ Concentration Module, fragmented RNA samples with sufficient
yield and an appropriate size distribution are ready for preparation of amplified
cDNA libraries.

Hybridization and ligation to Adaptor Mix

The fragmented RNA sample is next hybridized and ligated with either Adaptor
Mix A or Adaptor Mix B. These Adaptor Mixes are sets of oligonucleotides with a
single-stranded degenerate sequence at one end and a defined sequence required
for SOLiD System sequencing at the other end. Each Adaptor Mix constrains the
orientation of the RNA in the ligation reaction such that hybridization with
Adaptor Mix A yields template for SOLiD System sequencing from the 5" end of
the sense strand, while hybridization with Adaptor Mix B yields template for
sequencing the reverse complement (yielding sequence starting from the 3" end of
the sense strand). The downstream emulsion PCR primer alignment and the
resulting products of templated bead preparation for SOLiD System sequencing
are illustrated in Figure 8 on page 26.
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26

If you are preparing only one whole transcriptome library, use Adaptor Mix A. To
achieve higher confidence in the complete sequence of larger RNAs in the whole
transcriptome library, prepare two separate libraries, using Adaptor Mix A in the
hybridization reaction for one library and Adaptor Mix B in the hybridization
reaction for the other library.

Note: These libraries should not be mixed for the SOLiD System sequencing run
unless you also use different barcoded SOLiD 3’ Primers to amplify each library
(see “In-gel cDNA library amplification” below).

Adaptor Mix A
P1
@ 5. > o 3
LI TTTTTTTTTTTTTTITTTT ANASequence  intemnalAdapter ] barcode [ [[TTTTTTTTITITIT 5
i P2
5N NNNNT
FORWARD
Adaptor Mix B

P1 ,
g LTI 5

5
A
RNA Sequence Internal Adagter| barcode ,
e : P2

INNANNNYG
REVERSE

Figure 8 Strand-specific RNA sequence information from SOLID™ Whole
Transcriptome Analysis Kit products

Reverse transcription and size selection

Next, the RNA population with ligated adaptors is reverse transcribed to generate
single-stranded cDNA copies of the fragmented RNA molecules. After a cleanup
step using the MinElute® PCR Purification Kit, the sample is subjected to
denaturing gel electrophoresis, and gel slices containing cDNA in the desired size
range are excised.

In-gel cDNA library amplification (single- or multiplex) and final cleanup

The size-selected cDNA is next amplified using ~15 cycles of PCR that take place
in the gel slices. This step appends required terminal sequences to each molecule
and generates sufficient template for SOLiD System sequencing. Limiting the
cycle number minimizes the synthesis of spurious PCR products and better
preserves the RNA profile of the sample.

* To prepare template for singleplex SOLiD System sequencing, use the PCR
primers included in the SOLiD Whole Transcriptome Analysis Kit.

* For multiplex SOLiD System sequencing, use the 3’ PCR primers supplied in
the SOLiD Transcriptome Multiplexing Kit.
The 3’ (reverse) PCR primers in the SOLiD Transcriptome Multiplexing Kit
contain the P2 sequence required for SOLiD emulsion PCR, a unique
barcode sequence, and an internal adaptor sequence necessary for
sequencing the barcode (Figure 8). Use a different 3 PCR primer in the
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amplification reaction for each cDNA sample to generate a barcoded cDNA
library that can be mixed with other barcoded libraries for multiplex SOLiD
System sequencing. Plan the in-gel PCRs so that barcoded libraries are
generated using multiples of the color-balanced groups of four 3’ primers, to
preserve color balance during multiplexed sequencing on the SOLiD System.
For further information, refer to SOLiD™ Transcriptome Multiplexing Kit
Product Insert (PN 4441076) and SOLiD™ 3 System SETS Software Getting
Started Guide (PN 4389302).

The 5" PCR primer is identical in each kit; its sequence corresponds to SOLiD
emulsion PCR primer 1 (P1 in Figure 8).

After the PCR, the amplified cDNA is cleaned up using the PureLink™ PCR
Micro Kit. The yield and size distribution of each cDNA library is assessed; it is
important to have sufficient cDNA for accurate quantitation prior to SOLiD
System templated bead preparation, and to use only libraries with sufficiently long
inserts for SOLiD System sequencing.

SOLiIiD™ System The amplified cDNA library generated with the SOLiD Whole Transcriptome

templated bead Analysis Kit is ready for attachment to beads at the emulsion PCR step of the

ﬁ]raﬁ‘aj';a;;on (not SOLiD System sample preparation workflow. Refer to the Applied Biosystems
SOLiD™ 3 System Templated Bead Preparation Guide (PN 4407421).

Barcoded libraries are combined into color-balanced sequencing pools (in
multiples of four) just prior to templated bead preparation.

Sequences of the SOLID™ PCR primers included in the kit

Two SOLiD PCR primers are provided in the SOLiD Whole Transcriptome
Analysis Kit. The concentration of each primer is 25 uM. The primer sequences
are listed below.

SOLID™ 5" PCR primer  The 5' PCR primer is the SOLiD emulsion PCR primer P1.
5’- CCA CTA CGC CTC CGC TTT CCT CTC TAT GGG CAG TCG GTG AT -3’

SOLiD™ 3’ PCR primer 5’- CTG CCC CGG GTT CCT CAT TCT CTG TGT AAG AGG CTG CTG TAC
GGC CAA GGC G -3

Fragmented RNA cleanup using the PureLink™ RNA Micro Kit

After you fragment the RNA (page 5), you can use the PureLink™ RNA Micro Kit
(Invitrogen) to clean up the RNA instead of the RiboMinus™ Concentration
Module.

Note: It is not necessary to add 2-mercaptoethanol or DTT to the Lysis Buffer.
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1. Before using Wash Buffer II for the first time:
a. Add 60 mL of 96-100% ethanol directly to the bottle.

b. Check the box on the Wash Buffer II label to indicate that ethanol was
added.

c. Store Wash Buffer Il with ethanol at room temperature.

2. To the RNase IIT digestion and water, add 100 pL of Lysis Buffer and 250 uL
100% ethanol, then mix well.

3. Bind the RNA to the PureLink™ Micro Kit Spin Column:

a. Load 450 pL of the sample containing Lysis Buffer and ethanol onto the
Spin Column (with a Collection Tube).

b. Spin the column at 13,000 x g for 15 seconds at room temperature.

c. Discard the flowthrough.

4. Wash the sample:
a. Return the Spin Column to the Collection Tube.

b. Add 500 puL of Wash Buffer II with ethanol to the Spin Column.

(2]

. Spin the column at 13,000 x g for 15 seconds.

[o}

. Discard the flowthrough.

5. Wash the sample again:
a. Return the Spin Column to the Collection Tube.
b. Add another 500 uL of Wash Buffer II with ethanol to the Spin Column.
c. Spin the column at 13,000 % g for 1 minute.
d. Discard the flowthrough.
e. Return the Spin Column to the Collection Tube.

f. Using a pipette, carefully remove any buffer adhering to the top of the
o-ring inside the column.

d. Spin the column at 14,000 x g for 1 minute.

6. Elute the RNA:
a. Place the Spin Column in a clean Recovery Tube.
b. Add 12 uL of RNase-free Water to the center of the Spin Column.
c. Wait 1 minute.

d. Spin the Column at 14,000 x g for 1 minute.

7. Proceed with “Assess the yield and size distribution of the fragmented RNA”
on page 7.
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Selected settings in Agilent bioanalyzer software

Setting up a smear Perform a smear analysis to quantify the percentage of DNA in the 25—150 bp size
analysis range.

1. Select View » Setpoints tab.

2. Select the Global tab » Advanced settings.
3. Select Smear Analysis.

4. Double-click Table.

5. Inthe Smear Regions Window, select Add a region, and enter 25 bp and
150 bp for the lower and upper limits, respectively.

These settings are used to determine the percentage of total product that is
25-150 bp in length.

6. Add a second region, enter 25 bp and 180 bp, and select OK.

This is an arbitrary upper limit which will be used to determine the median
size.

7. View the Region Table tab, which will display the percentage of the total
product in the size ranges you have set.
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Manual determination
of median size

Under the Region Table tab, drag the upper limit line set in step 6 on page 29 to
the left or right until the Region Table indicates 50% of Total (Figure 10).
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Figure 10 Manual determination of median size
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Selected settings in Agilent bioanalyzer software

Table tab, you may see that the bioanalyzer software has identified

multiple peaks multiple peaks in a region that you want to consider as one peak. To obtain one
concentration and automatically determine median size for a peak region,
manually set the size range of the desired peak region (Figure 11):

1. Under

the Peak Table tab, right-click anywhere on the electropherogram and

select Manual Integration.

2. Drag the lower and upper region limits of the region with multiple peaks to
consolidate multiple peaks into one region.

3. The median size (bp), concentration (ng/uL), and molarity (nM) of each peak

region

Ble Context WYiew Electropherogram  Windows  Help

will be automatically calculated and displayed in the Peak Table.
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Second-round size selection of amplified cDNA

If >20% of the amplified cDNA library from step 4 on page 19 is in the size range
25-150 bp, or if you see distinct bands in the size range 100—150 bp, perform a
second round of size selecion of the amplified, double-stranded cDNA using
nondenaturing polyacrylamide gel electrophoresis.

Run the amplified cDNA 1. Add 4 pL Gel Loading Solution (AM8556) to the eluted cDNA (~20 pL)

on a nondenaturing from step 4 on page 19.
6% polyacrylamide gel.

2. Set up a 6% nondenaturing acrylamide gel.

a. Prepare gel mix; 5 mL is enough gel solution for one minigel.

for 5 mL Component
0.5mL 10X TBE (for example, Ambion® P/N AM9863)

0.75mL | 40% acrylamide (acryl:bis-acryl = 19:1; for
example, Ambion P/N AM9022)

to5mL deionized water

b. Stir at room temperature, then add:

50 L 10% ammonium persulfate in dH,O
5L TEMED

Mix briefly after adding the last two ingredients, which catalyze
polymerization, then pour the gel immediately.

c. Setup the gel following the manufacturer’s instructions for the details of
attaching gels to the running apparatus.

Use 1X TBE as the gel running buffer.

IMPORTANT! Do not heat the samples before loading.

3. Load the sample into 3 adjacent wells (8 uL. per well) of a nondenaturing 6%
TBE polyacrylamide gel.

Note: Include a separate well with 5 uLL 50 bp Ladder (40 ng/uL).

4. Run the gel at ~140 V for ~30 minutes.

Note: Nondenaturing gels must be run slowly to avoid heat denaturation of
the samples.

5. Stain the gel with SYBR® Gold dye, following the manufacturer’s
instructions.
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Excise the gel in the Illuminate the stained gel, then excise the gel in the size range 150-250 bp.

size range 150-250 bp

Note: If you are using a UV transilluminator to visualize the nucleic acid, work
quickly to limit its exposure to UV radiation.

Purify the amplified Use PAGE Elution Buffer (recipe below) and Spin Columns and Tubes
DNA from the gel (Applied Biosystems PN AM10065).

1. Prepare ~600 uL. PAGE Elution Buffer for each sample.

Component Volume

TE Buffer, pH 8 (10 mM Tris-HCI, ph 8, 1 mM EDTA) 5mL

5 M ammonium acetate (2.5 M final concentration) 5mL

Final volume 10 mL

2. Shred the gel piece:

a.

Use a 21-gauge needle to puncture through the bottom-center of a
0.5-mL microcentrifuge tube.

. Place the gel piece in the punctured 0.5-mL tube, then place the 0.5-mL

tube into a larger, 1.5-mL, nuclease-free microcentrifuge tube.
Spin for 3 minutes at 13,000 x g to shred the gel.
Place the 1.5-mL tube containing the shredded gel piece on ice.

Inspect the 0.5-mL tube, and if any gel pieces remain, repeat the
centrifugation step into a fresh 1.5-mL tube. Pool the gel pieces into one
collection tube using a pipette tip.

3. Elute the DNA in PAGE elution buffer:

Add 300 uL of PAGE Elution Buffer to the shredded gel pieces.

. Incubate the mixture overnight at room temperature, with gentle

agitation.

Transfer the buffer, which contains eluted DNA, to a fresh tube, leaving
the gel fragments behind.

Store the DNA on ice during the second elution (step 3e).
Add another 300 puL of PAGE Elution Buffer to the shredded gel pieces.

Incubate the buffer and gel pieces for 1-2 hr at 37°C, with gentle
agitation.

4. Remove the gel pieces from the sample using a filter spin column:

a.

Combine the PAGE elution buffer from step 3¢ with the buffer plus gel
slurry from step 3e.
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b. Cut a pipette tip to make a larger opening and use it to transfer the
combined PAGE elution buffer and gel slurry from each sample to a
Spin Column.

c. Spin the Spin Column at top speed for 5 minutes to remove gel pieces.
The DNA is now in the flowthrough.

Alternatively, you can use a 0.45 um-filter spin column from another
manufacturer for this step, following the manufacturer’s instructions for the
maximum centrifugation speed.

5. Precipitate the DNA, then resuspend in 20 pL of Nuclease-free Water:

a. Add 1/100 volume of glycogen and 0.7 volume of isopropanol to each
sample.

b. Mix thoroughly, then incubate at room temperature for 5 minutes.
c. Spin the sample at 13,000 x g for 20 minutes at room temperature.
d. Carefully remove and discard the supernatant, then air dry the pellet.

e. Resuspend the DNA pellet in 20 uL. of Nuclease-free Water.
Note: Accurate quantitation of the DNA is important for the
downstream SOLiD™ System emulsion PCR titration step. The

resuspension volume should yield DNA sufficiently concentrated for
accurate measurements (~10 ng/pL).
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General chemical safety

Chemical safety To minimize the hazards of chemicals:

guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by
the chemical manufacturer before you store, handle, or work with any
chemicals or hazardous materials.

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood). For
additional safety guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer’s cleanup procedures as recommended in the MSDS.

»  Comply with all local, state/provincial, or national laws and regulations
related to chemical storage, handling, and disposal.
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About MSDSs

Obtaining MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs)
with shipments of hazardous chemicals to new customers. They also provide
MSDSs with the first shipment of a hazardous chemical to a customer after an
MSDS has been updated. MSDSs provide the safety information you need to
store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure
to replace the appropriate MSDS in your files.

To obtain Material Safety Data Sheets (MSDSs) for any chemical product
supplied by Applied Biosystems or Ambion:

* At www.appliedbiosystems.com, select Support » MSDS. Search by
chemical name, product name, product part number, or MSDS part number.
Right-click to print or download the MSDS of interest.

* At www.ambion.com, go to the web catalog page for the product of interest.
Select MSDS, then right-click to print or download.

* E-mail (MSDS_Inquiry_ CCRM@appliedbiosystems.com), telephone (650-
554-2756; USA), or fax (650-554-2252; USA) your request, specifying the
catalog or part number(s) and the name of the product(s). The associated
MSDSs will be e-mailed unless you request fax or postal delivery. Requests
for postal delivery require 1 to 2 weeks for processing.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems or
Ambion, contact the chemical manufacturer.

Biological hazard safety

General biohazard

36

WARNING! BIOHAZARD. Biological samples such as tissues, body
fluids, infectious agents, and blood of humans and other animals have the
potential to transmit infectious diseases. Follow all applicable local,
state/provincial, and/or national regulations. Wear appropriate protective
equipment, which includes but is not limited to: protective eyewear, face
shield, clothing/lab coat, and gloves. All work should be conducted in
properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained
according to applicable regulatory and company/institution requirements
before working with potentially infectious materials. Read and follow the
applicable guidelines and/or regulatory requirements in the following:

+ U.S. Department of Health and Human Services guidelines published
in Biosafety in Microbiological and Biomedical Laboratories (stock
no. 017-040-00547-4; bmbl.od.nih.gov)
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* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

*  Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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